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WiseImage is a professional hybrid graphics editor and raster-to-
vector converter that work inside AutoCAD 
2000/2000i/2002/2004/2005/2006 and AutoCAD LT 
2002/2004/2005/2006.  
This Quick Start guide has been designed to teach you how to use 
WiseImage and WiseImage Pro for AutoCAD. You will be guided 
step by step through common operations and tasks. Please note 
that this Quick Start will not describe every command in detail. For 
detailed information refer to the User’s Guide and the Help. 
The procedures, buttons, and other interface elements, only 
available in the Pro version of WiseImage, are hereafter marked 
with ‘Pro Only’. The features and functions specific to WiseImage 
for AutoCAD LT are marked with ‘LT Only’. 
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Lesson1: Getting started 
Brief description: This section provides you with a basic 
knowledge of WiseImage – using WiseImage commands, loading 
and saving raster files, and tools to aid precision drawing.  

To run WiseImage 
1. Click Start on the taskbar, then point to Programs. 
2. Click on WiseImage, then choose WiseImage from the folder. 
AutoCAD starts automatically, and then WiseImage is loaded. 

Using WiseImage commands 
There are three options to run WiseImage commands: 

WiseImage toolbars: 
Most of WiseImage commands can be run from one of the 
WiseImage toolbars. You can manipulate WiseImage toolbars with 
the standard AutoCAD TOOLBAR command. 

The WiseImage Menu: 
This menu contains all WiseImage commands 

The Command Line: 
Each WiseImage command can be run from the command line. 
WiseImage commands start with the character r  
Example: rNew, rTrace… 
While performing most WiseImage commands, you can use the 
cursor menu for fast option selection. These are displayed if you 
right-click. The same menus are displayed if you right-click on 
some of the dialog box elements. These menus contain commands 
which can be applied to the selected element of the dialog box, or 
facilitate character entry in the dialog box. 

Working with Raster Images 
You can scan raster images directly from the program, load 
existing images and create new raster images. The program can 
handle any type of raster images that can be loaded into AutoCAD, 
with no size restriction. 

Scanning with WiseImage 
You can scan directly from AutoCAD with WiseImage, if you are 
using a CONTEX scanner or a scanner with TWAIN-driver. 
If a support scanner is installed, then choose it with the Select 
Source command of the rFile menu. Then start the Acquire 
command. The displayed dialog depends on the scanner and driver 
version.  
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Loading Raster Images 
In AutoCAD 2000/2000i/2002/2004/2005/2006 you can use the 
ImageAttach AutoCAD command. 
In AutoCAD LT 2002/2004/2005/2006 you must use the rOpen 
command instead. 

Creating New Raster Images 
You can create a new raster image. Choose New  from the rFile 
menu. Specify type, size, resolution and other properties for a new 
image. 

Saving Raster Image 
If you want to save the raster image, then use rSave or rSaveAs 
command.  
When you are saving an AutoCAD drawing WiseImage 
automatically saves all changed raster images inserted into the 
current drawing. If new images were created, then the program 
opens a dialog box for saving a new raster image where a user 
should specify the raster file name, location and format. 

Selecting an Image with WiseImage Commands 
Most WiseImage commands require that a user select the images 
to be operated on. Two standard selection procedures are 
provided: selecting one image and selecting a group of images. 

Selecting a Single Image 
If there is only one available image in the drawing, then it is 
automatically selected. 
To select a single image click on its border. 
If there are several available images, then you can select the 
required one after running command in the following dialog box: 

 
If you drag the cursor to the AutoCAD screen and hold it on an 
image, then its name will be highlighted in the list and it will also 
appear near the mouse cursor. To select the image, click on it. 
(Close the dialog by pressing the OK button.) 
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Selecting Several Images 
If there are several available images, then you can select the 
required ones before calling the command. In this case the 
operation will commence on the selected images. 
If you have not selected any image before staring the command, 
then a dialog box is displayed, containing a list of all available 
images. You should select those to be processed. 

 

Raster Snap 
WiseImage allows you to snap to characteristic points of raster 
objects. You can only use raster snap on monochrome raster 
image. When you select points on the image with raster snap 
mode on, a square raster snap pickbox appears on the cursor 
cross. Furthermore, you can snap to vector and raster objects at 
the same time. Raster Snap uses the same settings from Object 
snap settings as AutoCAD Vector Snap. The snap to a raster has 
lower priority. You can also use running snap and snap on 
demand. 
Note: You choose Raster Snap on demand by right-clicking with 
the Ctrl key pressed. 

 

 

Raster snap 

Tuning the raster snap  
Note: Raster snap quality is influenced by your image. 
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You can tune raster snap using the R2V Conversion Options 
dialog box. Choose Conversion Options from the rConvert 
menu, and then go to the Options tab. 

 
 
Specify the following values: 
Max Width – maximum width of a raster object, to which 
characteristic points you want to snap. Specify this parameter’s 
value as slightly greater than the maximum width of the raster 
line. 
Accuracy – parameter corresponding to your raster image 
accuracy. Use greater values for images of good quality and 
smaller values for images of poor quality. 

To turn on the running raster snap  
1. Using AutoCAD commands (DDOSNAP) turn on one or 
several object snap modes. 
2. From the rImage menu select Raster Snap, and then On. 

To turn off the running raster snap  
In the rImage menu select Raster Snap and then Off or click the 
button in the Raster Snap toolbar. 

Using Templates 
A template is a set of all dialog box settings, saved to a separate 
file on a disk. Template files are stored in corresponding subfolders 
of the TEMPLATE folder in the WiseImage root folder. You can use 
templates to save and restore the parameters of commands 
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Lesson2: Enhancing Scanned Images 
Brief description: This section demonstrates ways of enhancing 
scanned monochrome images: deskewing and filtering.  

Deskewing 
When paper is fed through a scanner the direction of the paper 
often deviates from the orthogonal, therefore the resulting 
scanned image is skewed, sometimes rather considerably. 
The special command – rDeskew is used to deskew an image.  
The command works in two modes: 
1. Auto Deskewing – program automatically estimates the 

skew value, and then performs deskewing. 
Choose Deskew from the rImage menu, and then –Auto. 

2. Manual Deskewing – you can use this mode, if the result of 
Auto Deskewing is not satisfactory. In this mode you can 
specify a skew angle by specifying a line, which must be 
horizontal or vertical. 
Choose Deskew from the rImage menu, and then –Manual. 
Press the Measure Angle button in the 
displayed Deskew dialog, and then 
specify the deskew line with two points. 
You can use snap tools during this 
operation. 

 

Deskew line (manual deskewing) 

 
After deskewing 
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Filtering Monochrome Images 
In WiseImage a number of different filters allow you to enhance 
the scanned monochrome raster image. You can apply filters to 
the whole image or to a fragment. You can also apply filters to 
several raster images simultaneously. 
Using the filters, you can 
• Remove raster speckles, 
• Remove holes (white points in black raster lines or filling), 
• Invert images, 
• Smooth raster objects, 
• Thin and thick raster objects and 
• Transform a filled raster area to one-pixel contour. 
All commands for filtering monochrome images are located in the 
rFilters menu. 

Speckle Remover 
Choose Speckle Remover from the rFilters menu 
You can specify the size of raster speckle on the 
screen using the measure buttons of the Speckle 
Remover dialog.  
If the Auto Estimating is on, then the program 
automatically estimates the speckle size. You can 
apply the filter several times. 

 
Before applying the Speckle Remover 

 
After applying the Speckle Remover 
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When applying the filter to the image of very poor quality some 
data may be lost. To avoid it, you can use the operation of 
separation by size. 

Hole Remover 
Choose Hole Remover from the rFilters menu 
You can specify the size of raster speckle on 
the screen using the buttons of the Hole 
Remover dialog box. If the Auto Estimating 
is on, then the program automatically 
estimates the speckle size. 

 
Before applying the  Hole Remover 

 
After applying the Hole Remover 

Inversion 
Choose Inversion from the rFilters menu  
This filter reverses the color of the 
monochrome image After applying this filter 
the background dots become the image dots 
and vice versa. 

 
Before applying Inversion 
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After applying Inversion  

Smoothing 
Choose Smoothing from the rFilters menu  
This filter smoothes raster object outlines, fills edge 
and inner background droplets, and partially removes 
raster speckles 

 . 

 
Before applying 

Smoothing 
After applying 
Smoothing 

The Smoothing filter is tuned by setting optimal values 
of Medianning and Threshold. You can tune and 

estimate the result before applying the filter in the 
preview window. 
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Thinning and Thickening 
Choose Thinning (Thickening) from the rFilters menu. 

Thinning filter makes raster objects thinner in the 
specified directions; by one pixel for each pass. You 
can specify a number of passes. 

 
Before applying Thinning 

 
After applying Thinning 

If needed, then you can apply the mode of thinning raster objects 
up to skeleton – i.e. only pixels in the middle are left. 
The Thickening filter makes raster objects thicker in the specified 
directions. You can specify a number of passes and choose any 
combination of thickening directions. 

Contour (4-coupling and 8- coupling) 
Choose Contour from the rFilters menu. 
The Contour filter converts filled raster areas to one-pixel 
contours. 
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Before applying Contour 

 
After applying Contour 

Separating Monochrome Images by Size 
This operation is effective in the following two cases: 
• Some small objects (dots in dashed-dotted lines, lines which 

consists of multiple small fragments, delimiters, etc.) are not 
speckles and should not be removed. 

• The image is of very poor quality. 
The principle of the separation by size operation is similar to 
speckle removing, except speckles are not removed but 
transferred to a new raster layer. The user can select fragments 
incorrectly transferred to this ‘speckle’ layer and bring them back 
to the drawing. 
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Original image 

 
The result of separating to basic and ‘speckle’ layers 
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The significant elements have been brought back from 
the ‘speckle” layer to the basic layer; the ‘speckle’ layer 

is removed 

Autocorrecting an Image 
Autocorrect runs a set of pre-defined operations. 

How to apply autocorrection 

• Choose Options from the 
Tools menu. Go to the 
WiseImage tab. 

• Specify a set of commands to 
apply with auto correction. 
Close Options. 

• Choose AutoCorrect from the 
rImage menu. 

• If you have more than one 
raster image in your 
document, then select 
image(s) to apply 
autocorrection to. 

 
NOTE: The program automatically defines all parameters of the 
commands included in the autocorrection set (except Rotate). For, 
example, automatic deskewing, removing speckles with automatic 
estimation of speckle size, and etc.  
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Lesson 3: Calibration 
Brief description: In this section you will learn how to eliminate 
distortions using calibration and four-point correction. 
 
Calibration is used to eliminate arbitrary (both linear and non-
linear) distortions of monochrome, gray-scale and color raster 
images. 
Note: You should calibrate the raster image before applying 
vectorization (tracing), because in case of vectorizing the distorted 
image you consequently obtain distorted vector data that is 
impossible to correct later.  
The original image must contain points with known coordinates. 
These points are called real points. You can use nodes of a 
rectangular grid as real points (if you work with mapping 
materials) and/or other points whose coordinates are known or can 
be calculated. 
The points, which correspond to the real ones on the distorted 
image, are often located with some displacement (i.e. they have 
different coordinates). These points are called measured points, 
as their coordinates value can be measured on the raster image. 
By applying calibration, the raster image is transformed so that the 
measured points coincide with or are extremely close to the real 
points. 
A transformation method is a parametric transformation used for 
calibration. Each model defines a family of transformations of the 
same type. There are several transformation methods: affine, 
bilinear, polynomial, spline, etc. 

How to calibrate an image 
Choose Calibration from the rImage menu. 

 
 
Defining real points 
We can define rectangular grid nodes and points with known 
(estimated) coordinates. 
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Step 1. Defining grid: 
 Grid is defined by the three parameters: start point (coordinates 
of lower-left node), cell size (by X and Y axis), and grid size (by X 
and Y axis). 

Press Define Grid  on the Calibration dialog. In the 
Calibration Grid dialog: 
Specify the number of grid cells along the X and the Y axis. 
Specify the base point. 
Specify the cell size. 

Step 2. Specifying measured points 
Press the Repick button on the Calibrationdialog. Specify a 
point the on image. To shift to the next point press Next 

Point . Program places the next point in the screen 
center and highlights it with grips. 

 
You see the real (correct) location of the first point with 

grips. 

 
Drag grips to the grid node on the scanned image – so 
you specify the ‘measured’ point. 
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Specifying points with known coordinates: 
Press the Add point button from the Calibration dialog. You 
can enter a name for the points in Label field. 

Step 3. Choosing calibration method 
Choose the Calibration Method in the Calibration dialog. 

 
 

How to choose? 
• If you are sure of the proper method, choose it from 

the list. Estimate the accuracy of this method by 

pressing the Estimate  button. 
• If you are not sure of the proper method, then select 

Choose automatically.  

Step 4. Running Calibration 
Run calibration by pressing the Apply button on the Calibration 
dialog. 
If you have more than one raster image in your document, select 
image(s) to calibrate. 

Four-point correction 
You can use this operation for quick correction of scanned 
technical drawings, which contain a frame. This operation assumes 
that both frame and contents of the image have the same 
distortion. 
How to correct an image by 4 points 
• Choose 4 point correction from the rImage menu. 
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• Enter the frame size in the Width and Height fields of the 4-

point correction dialog. 
You can also choose a standard frame size from the list of 
Frame Size or find the closest by pressing Find Closest 
paper. 

• Press Find Frame  – the program finds and highlights the 
image frame. 
If the frame is defined correctly, then press OK. Otherwise, 

press Measure frame , and then specify four points of the 
frame on the screen. Finally press OK. 
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Lesson 4: Restoring Images of Poor Quality 
Brief description: In this section we give you some 
recommendations about restoring images of poor quality. 
 
How to work with a raster image of poor quality? There is not 
much choice – either redraw it in the document with the 
corresponding program or restore it with a hybrid editor 
(Vectorization of such document produces poor results.).  
The purpose of this section is not to discuss the plus and minus 
points of each method, but to show you some methods to restore 
scanned documents of poor quality: 
• Separating an image by size – can be used for blueprints, 

images on dark backgrounds, with lots of speckles. 
• Editing selected raster objects (modifying their properties, 

geometry using «grips» and others). 
• Tracing in smooth mode. 
• Tracing in vector producing mode, followed by editing and 

rasterizing the obtained vector objects. 
• Drawing missing raster lines in Raster drawing mode. 
• Editing raster texts. 
Example of restoring an image  

 
Original image fragment 

 
Choosing and editing the axial line 
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Result of editing the axe line 

 
Tracing the curve in smooth mode 

 
Hatch on the original raster image 

 
Tracing the hatch in Create Vector and Keep Raster mode 

 
Rasterizing the vector hatch 
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Then you can apply the following actions: 

 
Edited raster image 

 
Selecting the whole raster image (or fragment) 
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Deleting isolated raster fragments from the selection  

 
Deleting speckles that were not selected 
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Lesson 5: Raster Selections 
Brief description: to perform different operations – such as edit, 
modify an object’s properties with the Inspector, and others – you 
need to select data to apply commands to. In this section we 
consider raster and vector data selection technology (raster 
images and their fragments; raster objects). You will learn about 
different selection modes and methods of data selection, and 
tuning raster selection. 
 
WiseImage allows selection of raster data. Selection technology 
and data selection methods are extremely close to vector object 
selection technology. 

Raster Selections: 
§ Raster objects (raster lines, arcs, circles, selected 

with object selection methods, which come with 
‘grips’, properties and precise geometry). 

§ Area fragments of the raster image. 
Selected with window or polygon.  
Raster line segments of arbitrary shape. (A 

segment represents a raster line of arbitrary 
shape, limited by points of intersection with 
other raster lines or endpoints).  

Isolated raster fragment. 

There are two toolbars for data selection: Raster Select and 
More Selection. 
Note: When selecting data, you need to define the selection 
parameters: 
• Selection modes – add to selection, remove from selection, 

single selection 
      Selection method – by picking, within window, crossing 
polygon and others. 
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Selection modes 

 
New data is added to selection 

 
Selected data is removed from selection 

 
Every new selection deselects previously selected data 

 
Selects all raster image contents 

 
Deselect All 

Raster Selection Methods 

Table 2 Selection methods 

Object selection methods  
You can select raster objects (raster line, arc, circle) using object 
selection methods: 

 
By Picking 
(Auto)  

By 
Crossing a 
Window 

 
Within a 
Window  

By 
Crossing a 
Polygon 

 
Within a 
Polygon  

By Fence 
 

You can also select raster objects by reference objects: 

 
raster line or its segment by 2 points 

 
raster arc or its fragment by 3 points 

 
raster circle by two points 

How to obtain area selection using object selection methods 
IMPORTANT: If you need to obtain 
an area selection when selecting 
raster objects, then press the 
Disable Raster Object Production 
button, located on the Select 
toolbar. 
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Selecting area raster fragments 
Selecting inside rectangle or polygon 

You can select rectangular or polygonal fragments of raster image 
area using Select by Rectangle and Select by Polygon, located 
on the Raster Select toolbar. 

 
rectangular fragment of raster image 

 
polygonal fragment of raster image 

 

 
Selecting raster segments 

Segment represents part of a raster line of arbitrary shape, 
limited by intersection points with other raster lines or endpoints. 
You can select raster line segments: 

 
Within a window 

 
Within a polygon 

 
By crossing a window 

 
By crossing a polygon 

 
By fence 

 

 
Selecting isolated raster fragments 

You can select isolated raster objects: 

 
By picking 

 
Within a window  

 
Within a polygon 

 
By crossing a window 
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By crossing a polygon  

 
By fence 

 

 
It is convenient to select raster areas of irregular shape using the 
following selection methods:  

 

Brush Selection  

 

 

Contour Selection 

 

Tuning raster selection 
You need to tune the geometry of rater data to obtain the best 
results when selecting raster objects and raster segments. 

How to tune raster selection 
The selection geometry is tuned using the 
R2V Conversion Options dialog. 
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To open this dialog, choose Conversion Options from the 
rConvert menu, and then go to the Options tab. 
Specify the following values in the Options tab: 
Max. Width – maximum width of raster objects to select. 
Specify this parameter’s value as slightly greater than 
maximum width of raster objects or raster line segments. 
Max. Break – length of ignored break of raster lines. 
Accuracy – your document accuracy. For example, if when 
selecting a raster circle by picking, then the program only 
selects its fragments (arc), reduce the accuracy value. 
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Lesson 6: Raster Editing 
Brief description: This section provides you with different methods 
of editing selected data – raster, and also the commands designed 
for editing raster images. 

Editing data, selected with object selection methods 
Let us consider different methods of editing raster data, selected 
with the object selection methods: 
You can view and edit the properties and geometry of selected 
objects using the AutoCAD Property window. 

 

Selected raster object The raster object properties in the 
Properties window 

• You can change the geometry of raster objects, and also the 
location of selected objects on screen using ‘grips’. 

Editing Raster Image 
The commands from the rImage menu are designed for editing 
raster images. 
The commands from the rImage menu modify the raster image 
contents – resolution, real size, size in pixels, point’s positions. 
You should know the difference between the editing images using 
AutoCAD commands, and those of the rImage menu. Unlike the 
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commands of the rImage menu, the AutoCAD commands do not 
change the raster image contents. For example: 
• The AutoCAD Scale command of the AutoCAD Modify menu 

only changes the scale of raster insertion; the raster image 
contents (resolution, number of points and location) are not 
changed. 

• Using the Scale field of the Resample dialog box, you can 
modify the raster image contents – resolution and/or the 
number of points the image is composed of. 

Change Image Size 
Choose Change Size from the rImage menu 
Using the Change Size dialog box you can: 
• Change the image size to the desired format: 

Change the desired format from the list of Standard Paper 
Size. Set the orientation – Portrait or Landscape. 

• Change the image size to the closest standard format:  
Press Find Closest. 

• Add (cut) image margins: 
Specify values to added (cut) margins in the 
Alignment/Margins field. 

You can also align the image position relative to its margins: 
• Using one of the nine buttons of the Alignment/Margins 

field. 
• Entering the margin values in the Alignment/Margins 

section with the Fixed Size checkbox set to on. 

Resample 
Using the Resample dialog from the rImage menu you can: 
• Proportionally change the image size with fixed resolution. 

§ Choose measurement units from the list; you can 
choose pixels as measurement units. 

§ Enter the new values in the Width and Height fields. 
§ The Fixed size in pixels checkbox is off. 

• Change the image size according to the specified Scale value 
with fixed resolution. 

§ Enter the new scale value in the corresponding field.  
§ The Fixed size in pixels checkbox is off. 

• Change the image resolution; with fixed size. 
§ Enter the new resolution value in the corresponding 

field. 
§ The Fixed size in pixels checkbox is off. 

• You can change the image resolution (size); the number of 
pixels is fixed. 

§ Turn on the Fixed size in pixels checkbox. 
§ Enter the new resolution (size, scale) value. 
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Cropping Image 
Cropping commands are located in the Crop submenu of the 
rImage menu. 
You can: 
• Crop blank margins of the raster image. 
• Crop the raster image by its frame. 
• Crop the raster image by a rectangle specified on screen. 
• Crop the raster image by clip. 

Rotate and mirror 
These commands located in the rImage menu, allow you to rotate 
an image by 900, 1800, 2700, or by an arbitrary angle; and also 
mirror an image about the X or Y-axis. 
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Lesson 7: Editing color images 
Brief description: This lesson is devoted to methods of enhancing 
color and grayscale raster images – correcting image brightness, 
contrast, hue, and saturation; correction by histogram, and 
filtration. You will also learn about converting images to RGB, 8-bit 
indexed and grayscale; layering color and grayscale images to 
monochrome layers. 

Correcting image brightness, contrast, hue, and 
saturation 
You can tune brightness, contrast, hue and saturation of color and 
grayscale images. 
Choose Brightness/Contrast from the Image menu. 
Using Brightness/Contrast dialog, you can tune: 
• Brightness of color and grayscale image 
• Contrast of color and grayscale image 
• Hue of color image 
• Saturation of color image 
You can tune the parameter’s value using the sliders or entering 
the values in the corresponding fields. 

Correction by histogram 
Using correction by histogram you can tune the image brightness, 
hue and contrast. You can apply automatic correction or tune the 
parameters manually. 
Choose Equalize from the rImage menu. 
To correct an image by histogram automatically use the Auto 
button of the Equalize dialog.  
To correct an image manually you need to 
specify three values: lightest and darkest 
levels, and image gamma – for each channel 
or for Master channel. 

 
• The darkest level (the left slider 
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position) is set with the dark eyedropper 

, using which you can specify the 
colors to turn black. 
All pixels included in the histogram area 
from 0 to the left slider, will turn black. 

• The lightest level is set with the light 

eyedropper , using which you can 
specify the colors to turn white. 
All pixels included in the histogram area 
from the right slider to 256, will turn 
white. 

• Using the middle slider, specify the 
value of image gamma. 

Moving the middle slider to the left increases the gamma value; 
the image becomes lighter. 
Moving the middle slider to the right reduces the gamma value; 
the image becomes darker. 
• When you achieve satisfactory results in the Preview window, 

press Apply. 

Color filters 

Blur  
This filter produces a blur effect on an image. For example, you 
can apply the Blur filter to an image area that has texture fills. 

 

Choose Blur from the 
rFilters menu. 
• Set Radius for the 

filter. Increasing the 
Radius value also 
increases image 
blurring. To modify the 
Radius value, use the 
slider or enter the 
value in the field. 

• When you achieve 
satisfactory results in 
the Preview window, 
press the Apply 
button. 

 

Unsharp Mask 
This filter is designed to increase the sharpness of color 
boundaries, producing an overall increase of image sharpness. This 
filter can be used to correct images that became blurred after 
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interpolation – e.g., after such operations as rotate, scale, 
alignment, calibration or four-point calibration, and also resize and 
resample. 
Choose Unsharp Mask from the rFilters menu. 

 

Set Radius – ‘level’ of 
the filter effect. 
Increasing the Radius 
value increases a 
number of pixels 
surrounding the color 
transition boundary that 
are to be processed. 
Applying small Radius 
values results in an 
increase of sharpness 
only on color 
boundaries. 
• Set Sensitivity for 

the filter using the 
slider or enter the 
value in the 
corresponding field. 
Increasing this 
value provides a 
stronger effect. 

 
• When you achieve satisfactory results in the Preview window, 

press the Apply button. 

Median 
This filter reduces image noise analyzing all pixels within the 
specified radius and assigning the central pixel the averaged value 
of reviewed pixels. As a result, pixel color and brightness are 
evened. For example, Median filter can be used to eliminate image 
‘grain’. 
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Choose Median from the 
rFilters menu. 
• Set Radius for the filter – 

area within which color 
values are to be 
analyzed.  

• When you achieve 
satisfying results in the 
Preview window, press 
Apply. 

 

Convert to 24-bit RGB, grayscale, indexed 

Convert to RGB (grayscale) 
• If your document contains several raster images, select the 

one(s) to convert to RGB (grayscale). 
• From the rImage menu, choose Convert to, and then 

Convert to RGB (Convert to grayscale) 

Convert to indexed  
You can convert full-color images (24 bit per pixel) and 
monochrome images to 8-bit indexed (8 bits per pixel).  
This operation can be used to reduce the size of a full-color file, 
and therefore speed up working with it. Note, that in some cases 
the converted image might have lower quality due to some 
information loss. 

• If your document contains several raster images, then select 
the one(s) to convert to 8-bit indexed. 

• From the rImage menu, choose Convert to, and then 
Convert to indexed. 

 Execution order 
Calculating the 
optimal palette 
for the 
selected 
image(s) 

Press Set auto palette . 

Recalculating 
of palette for 
specified color 
number 

Specify the color number in the Colors 

 field. 

Press Reset Palette  button.  
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Selecting 
colors from the 
palette 

Press Shift, select colors from the palette by 
clicking on them (if only selecting one color, 
then there is no need to press Shift.). 
Note: You can view selected colors in the 
Preview window, – select the Light Paint 

 checkbox. 
Merging 
selected colors  Press Merge Colors  button 

Deleting 
selected colors  Press Delete Colors  button 

Changing 
selected 
color(s)  

To change selected color(s):  
To the specified color– Press Get color to set 

 and choose a desired color from the 
Color box.  
To one color of the image– press the button 

with eyedropper , and then specify a 
desired color on screen. 

Adding 
color(s) to the 
palette 

Enter desired number of colors in the Colors 
field. 

Press Set auto palette   – or  – 
Click on a blank palette cell. 
Click on the added field, and assign the color 
as described above in section Changing 
selected color(s). 
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Lesson 8: Separating color images to 
monochrome layers 

Brief description: This section describes the operation of 
separating color or grayscale raster images to monochrome layers. 
Binarization allows you to extract pixels of specified colors (or 
close to them) to a monochrome layer. For example, when you 
binarize a map, first you get a monochrome layer that contains 
isolines; then a layer that contains roads, etc. 
Color Separation allows you to separate a color and grayscale 
image to several monochrome layers with a single operation; each 
image pixel is transferred to one of the resulting monochrome 
layers. 

Binarization 
Using binarization you need to specify the color range(s) for a 
created layer, e.g., for hydrographic layer – from light-blue to 
dark-blue.  
• Choose Binarization from the rImage menu. 

 
• Choose binarization method – Range or Threshold. Set the 

parameters for the chosen method (Color model (RGB, HSV, 
Gray), channel (gray, red, green, blue, hue)). 

• Specify a layer and its color to place the new monochrome 
image to. 

• Using one of these eyedroppers  specify the colors 
on screen; they are added to the Colors list.  The estimated 
binarization results are highlighted in the preview window. You 
can choose any incorrectly selected color from the list, and 

then remove it using Delete  button. 
• Tune the results using the sliders, located in Ranges 

(Threshold). 
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• You can delete small speckles that appear using the slider 
Noise Reduction. 

• When you achieve satisfactory results in the Preview window, 
press the Apply button. 

Color separation 
To execute Color separation you first set color categories (thematic 
layers), by which you want to separate the image, and then you 
set a list of colors for each category. 
• Choose Color separation from the rImage menu. 

 
• Specify the first category color on the image using the 

eyedropper Add category . Choose a standard color; 
specify a name for the category in the displayed Category 
name and color dialog. 

• Using the eyedropper Add color specify all colors of the 
image, which should fall within this category.  

• Repeat the previous two steps for all categories, which you 
want to set on a new layer. Incorrectly defined categories and 
colors can be selected and deleted from the list using the 

Delete  button. 
• Using the Noise Reduction slider you can adjust the 

sensitivity of Color separation – smooth contours. 
• Deleting small-sized speckles is executed when the 

Despeckling checkbox is set to on. 
• When you achieve satisfactory results in the Preview window, 

press the Apply button. 
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Lesson 9: Rasterizing, merging raster 
images 

Rasterizing Vector Data 
Brief description: You can rasterize vector objects on raster images 
Select the vector objects, located over the raster image, and then 
start the Vector To Raster  command from the rConvert  menu. 

 
Original vectors 

Rasterizing on 
monochrome raster 

Rasterizing on color raster 

If you have more than one raster image in your document, select 
the image(s) to place rasterized vectors on. 

Merging raster images 
You can merge a raster image or raster selection with another 
raster image. 
Select a raster image (or its fragment) and choose Merge or 
Merge a Copy from the rEdit menu. 
If part of raster selection is placed outside the destination raster 
image area, then it disappears. 
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To perform the operation, first you select the source images. They 
are selected as AutoCAD objects. You can select a raster image of 
any type (color, grayscale or monochrome) as a source image. 
Raster selection can also be used as a source image.  
In the second step, you select the destination images. This 
selection is made from the selection dialog box. 
If you have more than one raster image to merge in your 
document, then select image(s) to merge. 
When selecting destination images, the program considers the 
types of previously selected source images. You are allowed to 
insert the data of the source images with less color depth into the 
destination images with a greater color depth: monochrome into 
grayscale and color, grayscale into color (not into monochrome) 
color into color only. The names of images that do not fit are 
excluded from the list of the dialog box. 
Merging a Copy (i.e. duplication) works in a similar way as 
merging except it does not erase the source image from the 
drawing.  
To perform duplication you perform the same actions as when 
merging except the command is called Merge a Copy and the 

button looks like . 

Transforming Selection Set into Separate Image 
The detaching operation transforms a selection set into a separate 
image (or a group of images, if a selection was made on several 
images) without changing the position or size of raster selection.  
A selection set is always transformed into a separate image if its 
position or size is changed. 
In some cases it is necessary to transform a selection set into a 
separate image, without changing the raster selection position or 
size. For example it is necessary when layering raster images, 
when the original image is divided into two images of the same 
size, lying one above another. Such raster layers creation allows 
separating raster image objects of different types onto separate 
layers as it is made in AutoCAD for vector objects. For example, 
you can select all raster texts and move them to a separate layer 
in order to further recognize texts. 

To create an image, containing part of another 
image  

1. Select raster data. 
2. From the rEdit menu select Selection to New Image. 

 - or - Click the button 
 
on the WiseImage toolbar. 
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Lesson 10: Tracing 
Brief description: To describe the use of tracing as an interactive 
(or semi-automatic) vectorization procedure. 
During the tracing procedure raster objects are specified one by 
one; these are then recognized and converted to corresponding 
vector objects.In the process of tracing the initial raster objects 
can be deleted, smoothed or left intact. 

Tuning tracing 
You should tune the tracing parameters before applying this 
procedure. 
Tracing is tuned in the R2V Conversion Options dialog. Choose 
Conversion Options from the rConvert menu. 

Tuning geometry of traced objects: 
Open the Options tab of the R2V Conversion Options dialog.  

 
Max. Width – maximum width of traced raster objects. 
Measure width of the widest traced lines. Set this 
parameter’s value as slightly greater then the measured 
width. 
Max. Break – length of ignored break of raster lines. 
If you trace dashed lines, then set the value of this 
parameter as slightly greater than the maximum gap 
between dashes. 
Accuracy – set the maximal accuracy value for tracing 
polylines to high (for a closer approximation of raster 
curves with vector polylines). In other cases increase the 
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accuracy value for images of good quality; and reduce the 
value– for images of poor quality. 

Layering resulting vector objects 
You can place resulting vector objects on different layers: 

 
• Open the Separate tab of the 

R2V Conversion Options dialog. 
• From the pull-down list of Layer select one to place 

the traced vector object. 
• Select the Use Table checkbox. 

Orthogonalization mode with tracing 
When tracing lines and polylines, you can use orthogonalization 
mode, which allows you to obtain orthogonal lines or polylines 
that consist of orthogonal segments (the base angle can be 
calculated automatically or specified). 
• Tracing lines with orthogonalization 

Note: The operation can only work if the raster line you want 
to trace deviates from the orthogonal (specified) direction by 
not more than 20. 
To turn on line orthogonalization mode: 

§ Open the Options tab of the 
R2V Conversion Options dialog. 
Select the Ortogonalization checkbox. 

§  enter the base angle value in the Base Angle field. 
 

Tracing modes and commands 
Before executing tracing, you should choose a tracing mode. 

Tracing modes 

 
 

 Original fragment 
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 Produce vector and keep raster 

 
 

 Produce vector and erase raster 

 
 

 Erase raster without producing vector 

 
 

 Smooth raster without producing vector 

Tracing commands 

You can trace: 

 
Lines, arcs, circles with auto recognition 

 
Lines by two points 

 
Arcs by three points 

 
Circles by two points 

 
Hatches 

 
Raster symbols 

 
Polylines 

 
Outlines 

How to trace 
• Set the tracing parameters 
• Choose from the Raster to vector toolbar or the rConvert 

menu: 
§ Tracing mode 
§ Tracing command 

Tracing lines, arcs, circles, and outlines 

 
You can trace raster lines, arcs, circles, and 
outlines with automatic recognition of their type 
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– click once on the desired object. 

 

 

 

If you work with a complicated image, or an 
image of poor quality, or you need to vectorize 
only part of a raster entity, then you can apply 
forced tracing. 

Auto extension mode: When tracing lines or arcs you can use Auto 
extension mode – you only specify a fragment of the object, but 
the program recognizes the whole object. To switch to this mode, 
select the Auto extend vectors checkbox in the Trace tab of the 
R2V Conversion Options dialog. 

Tracing Hatches 
To trace a hatch, you need to intersect all its lines with a crossing 
polyline. 
Tip: raster lines that cross the hatch, interfere in the recognition 
operation, so before tracing the hatch it may be useful to trace 
these lines and erase the original raster. 

  

Original hatch 
Tracing lines that intersect 

hatch (with erasing the 
original raster) 

 

  

Tracing hatch – 
intersecting hatch lines 

Result of hatch tracing (in 
Produce vector and Erase 

Raster mode) 
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LineFollowing 

 
LineFollowing produces vector polylines that 
approximate complex raster curves. 
To increase accuracy of approximating vector 
polyline to the original raster curve increase the 
Accuracy slider in the Options tab of the 
R2V Conversion Options dialog. 

How to trace polyline? 
• Select tracing mode (e.g., Produce Vector and Keep Raster). 
• Press the Trace Polyline button. 
• Specify a point on the raster curve – the program tracks this 

curve up to the nearest intersection and waits for you to 
indicate the direction in which tracing should continue. You 
can also use the Autodetect direction mode: Open the 
Trace tab of the R2VConversion Options dialog. Select the 
Autodetect direction checkbox. Set the waiting period (in 
sec) in the Pause field. 

• If you turn on the Autodetection direction mode, and you 
are satisfied with the direction, indicated by cross, then press 
the Space key (Alternatively, the program continues tracing 
after the waiting period expires.). If you are not satisfied with 
the direction as suggested by the program, then specify the 
right direction on the screen. If Autodetection direction 
mode is Off, you must specify the next fragment of the raster 
curve on screen (fragment between two nodes or between 
node and end point of the raster line). 

When tracing polylines you can use several input options: to enter 
a key letter into the command line, the cursor menu, or the Line 
Following panel buttons.  
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Button and 
option 

Description 

 Direction 
Reverses a tracing direction 

 Backstep 
Cancels the latest tracing step 

 
BackSegment Cancels the latest polyline segment 

 DrawLine 
Enables adding a linear segment of a 
polyline without tracing. Several segments 
can be added with SHIFT pressed. 

 Center 
Zooms the image to show the last added 
polyline vertex in the screen center  

 Redraw 
Redraws AutoCAD screen in the Line Follow
mode 

• If you need to change the tracing direction, then chose 
Change direction from the Right Button Menu. 

• To cancel the last segment of the vector polyline, select 
BackSegment from Right Button Menu. 

• To cancel the last step, select BackStep from Right Button 
Menu. 

• If needed you can draw segments in Free Hand Drawing 
mode, then select DrawLine from Right Button Menu. and 
specify the new nodes of the vector polyline on screen. 

• When you have completed tracing the polyline, press Enter. 
You can use the Centralize View command of the context menu. 

Tracing polylines with orthogonal segments 
When tracing, you can obtain vector polylines with orthogonal 
segments. For example, this mode can be used to trace buildings 
on scanned maps. 
The angle for orthogonalization can be estimated automatically or 
specified. 

 
To obtain polylines with orthogonal segments: 
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Open the Trace tab of the R2VConversion 
options dialog. Select the Line Follow 
Orthogonalization checkbox. 
Select the Autoestimate base angle checkbox. 

Tracing Outline 
You can trace raster outlines. Tracing results depend on the 
parameters and mode of tracing. Tracing parameters are set in the 
Trace tab of the R2V Conversion Options dialog. 

Setting parameters of tracing outline 

Auto Extend 
vectors – Off 

Creates vector 
on two colors 
boundary.  

Auto Extend 
vectors – On 

Creates vector at 
the center of 
raster line. 
 

Export single 
contour – Off 

Creates outer 
and nested 
outlines. 

Export single 
contour – On 

Creates the 
outer outline 
only. 

 
Auto Extend 
vectors – On 
Export single 
contour – On 

 Trace mode 
– keep raster  

Raster data 
inside the outline 
is kept. 

Auto Extend 
vectors – On 
Export single 
contour – On 

 Trace mode 
– erase raster. 

Raster data 
inside the outline 
is erased. 

How to trace outline? 
• Run the Trace Outline command. 
If several available raster images are inserted into a drawing, then 
a selection dialog box appears. 
•  Specify a point inside the outline. 
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Lesson 11: Automatic vectorization, text 
recognition 

Brief description: Automatic vectorization is a procedure for 
converting raster data to appropriate vector objects. 
 
WiseImage recognizes the following objects on monochrome 
rasters when vectorize: lines, arcs, circles, hatches, texts and 
symbols. Raster curves and filled contours can be approximated 
with polylines. 
Color raster images can be converted to vector polylines. 
The program can recognize line styles and arrows on line and arc 
ends. 
You can round vector object widths to previously specified values. 
You can also place vector objects corresponding to raster lines of 
various widths on different layers and/or assign different colors to 
them. 

Tuning Vectorization 
You can use one of the pre-defined templates or tune the 
parameters yourself. Vectorization settings can be saved as a 
template for further use. 

 
Automatic vectorization is tuned in the Conversion Options 
dialog. To open this dialog, choose Conversion Options from the 
rConvert menu. 
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Select objects to recognize: 
Open the Recognition tab of the Conversion Options dialog. 

 
Select the entities, which you want to obtain after 
vectorization. 
The additional parameters for recognized objects, such as 
line type, arrows, hatch angle, and others are located on 
the second level. Click on the ‘+’ to get access to these 
parameters. 

Points 
WiseImage will recognize a raster point with a size not less than 
2x2 pixels (Objects smaller than this are considered as speckles 
and thus ignored.), and which maximum vertical and horizontal 
extents are not greater than Max Width value.  
Do not switch on this mode when recognizing images of poor 
quality or images containing many speckles, since speckles cam be 
recognized as points. 
Lines 
Turns On the algorithm for line recognition. As a result LINE 
entities are created. 
Arcs and Circles 
Turns on the algorithm for recognizing raster circles and arcs. 
Polylines 
This algorithm approximates central lines of raster objects by 
polylines (POLYLINE). The algorithm creates polylines consisting of 
straight segments only. You can use this algorithm individually (or 
with the Outlines algorithm) for vectorization of maps and other 
images consisting of arbitrary lines 
Outlines 
This algorithm is used to approximate outlines of flooded areas by 
polylines. This algorithm creates closed polylines, approximating 
the boundaries of raster objects. The boundary polylines consist 
only of straight segments. 
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The algorithm traces raster lines whose width is greater than the 
value of the Min width parameter. To obtain outlines of all raster 
objects, you only need to choose outlines with the Max Width 
parameter to 0. 
Hatches 
Selects the algorithm for hatch recognition. WiseImage Pro 
recognizes simple raster hatches and creates AutoCAD blocks, 
consisting of segments. The Hatches algorithm searches for 
hatches only if the Lines algorithm is also on. 

Symbols 
Selects the algorithm for raster symbol recognition with specified 
samples.  

Setting the geometry of vectorized drawing: 

 
Min Length –minimum length of a raster object to be recognized.  
Max Width – maximum width of raster lines. Set the value of this 
parameter to be slightly greater than the measured line width on 
your drawing. 
Max Break – maximum accepted length of a break in a raster line 
to be ignored. Set the value of this parameter to be slightly 
greater than the distance between dashes in dash lines or the 
broker distance in poor quality lines. 
Text Height – Set the value for this parameters equal to the 
maximum height of raster text symbols of upper case. 
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Accuracy – this parameter corresponds to the accuracy of your 
raster image. Use high Accuracy value for images of good quality, 
and low Accuracy value– for images of poor quality. 
Custom Hatch – angle for recognition non-standard hatches. 
Orthogonalization – Select this checkbox to obtain orthogonal 
vector lines as a result of vectorizing raster lines, which deviate 
from the orthogonal direction by not more than 20. You can also 
align vector objects to a specified base angle. 

Separating vector objects by layer and /or by color 
The criterion for separating vector objects by layer and/or color is 
the width of the original raster lines. 

 
In the Separate tab of the R2V Conversion Options dialog, 
you can specify for resulting vector objects: 
• Width, 
• Color 
• Layer 
 

How to vectorize 
• Set the vectorization parameters. 
• If you have several images your document, then select the 

one(s) to vectorize. You can also vectorize a selected image. 
• Choose Raster2Vector from the rConversion menu. 

Text Recognition 
This section provides information on various algorithms for 
recognizing raster text; the procedure and parameters of setting 
up raster text recognition. 

Text Recognition Algorithms 

 

You can use the following algorithms for 
working with the raster text. You can 
choose them using the Recognition tab 
of the R2V Conversion Options dialog. 
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None – this algorithm searches for raster 
text areas without vectorizing. 

 

Text Areas – this algorithm recognizes 
and creates text areas. You can enter 
text information in these text areas using 
the procedure of editing recognized texts. 

 

Polylines (Outlines) – approximating 
the raster text with vector polylines 
(outline). 

 

OCR – recognizing the raster text and 
creating text objects. 

Text Recognition 
• Select the Text Area checkbox in the Recognition tab of the 

R2V Conversion Options dialog. 
• Choose your required algorithm for working with the raster 

text. 
• In the Options tab of the R2V Conversion Options dialog 

enter the Text Height value equal to the maximum height of 
raster text symbols of upper case. 

• Tune the text recognition options in the Texts tab of the R2V 
Conversion Option dialog. 

• Editing recognized texts  
The procedure of editing recognized texts (text areas) is used 
after recognition with the OCR module or with Text Areas 
recognition. 

After applying automatic vectorization choose the command Edit 
OCR Texts from the rConvert menu. The program displays the 
first recognized text fragment (area) in the Text Correction 
dialog.  

 
You can edit the text area contents. To accept the text and 
move on to the next one press Accept Recognized Text. To 
delete the current text press Delete OCR Text. 
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Text Recognition Options 

 
Orientation – choose the orientation for raster texts contained 
in the image. 
Overlapped by Graphics – if this option is on, the program 
searches for raster texts, crossed with other raster objects. 
Tip: It is not recommended to use this mode when working 
with complicated documents to avoid possible mistakes such as 
incorrect recognition of small graphic objects as text. 
Standalone Letters – allows searching for standalone text 
characters.  
Tip: If this option is off, then the program does not search for 
standalone text characters, but you can avoid incorrect 
recognition of small objects. 

Patterns – If you use the OCR module, then you should set 
patterns for text inscriptions contained in the raster document to 
obtain better recognition results – select the Word pattern 
checkbox.  
If Patterns are not specified, then the program uses a set of 
standard patterns. 
Height Table – If after vectorizing you want to obtain texts of 
specific height(s), then enter the desired text height(s) in the table 
and select the Height Table checkbox. If you specify several 
height values, texts height will be rounded to the nearest value 
from the list. 
Template file –file for storing topology models of text characters, 
which are used when performing OCR. 
You can also train the program to recognize other text characters 
or different forms of characters contained in the standard template 
file. 
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Setting Text Pattern 
Here is formal description of a word pattern definition: 
“[% [length]character type] II [ letter] ]…”… 
D Digits 
N Capital letters of national alphabet 
n Small letters of national alphabet 
E Capital letters of Latin alphabet  
e Small letters of Latin alphabet  
S Special characters (signs of plus, 

minus, equality, degree, and others) 
Examples: 

Symbol sequence Pattern 
5    25     5559     22.9 %D 
R25     R15     R13 R%2D 
Moscow     Hanover %1E%e 
project     design %n 
5V     220V     13.8V %DV 
120     300     450 %2D%1S 

Training OCR 
You can train the OCR module to recognize new characters. You 
can add a new character to one of the standard template libraries 
or create your own. 
Tip: In some cases it is more convenient to use the standard 
library (e.g., DEFAULT.OCR) as basis, having saved it with a new 
name. 
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To train the program to recognize a new character or different 
forms of existing characters: 
• Choose Train OCR from the rConversion menu  
• Open (create) OCR-file 
• Enter a character to recognize in the Character field  
• Select the corresponding character on the raster image using 

selection buttons 
• Press ‘+: to add the new pattern to the OCR-file 
 

Color Vectorization 
Color vectorization is intended for recognition of linear objects on 
color schematic raster images (plans, schemes, maps) with their 
further vectorization by polylines. WiseImage defines the color 
table for an initial image automatically assigning the nearest color 
from this table to resulting vector objects. 

Tuning color conversion options 
Choose Color Conversion options from the Convert menu. 
Set the following parameters in the R2V Color Conversion dialog: 
• In the Binarizing section– Radius and Threshold. Starting from 

the minimum increase the values of these parameters 
gradually until you get the required quality of the 
monochrome raster image in the preview window 

For convenience you can use the Show/Hide buttons in the Preview 
window: 

  – Hide Source Raster;  

  – Hide Raster (binarization result); 

   – Hide Vectors. 
Use the Smoothing slider to smooth raster lines, if necessary. 
• In the Recognition section – Min. length and Max. width and 

Accuracy. 
The Min. length and Max. width are set in the same way as in the 
Automatic vectorization procedure.  
Use the Accuracy slider to get a raster object in the preview 
window approximated by a vector object in the best way.   
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• Select the Separate by Color checkbox to distribute the 

resulting vector objects of different color by different layers. 

Set a layer, output color and width for the resulting vector objects 
in the appropriate columns of the table. 
• To vectorize lines of a specific color you should clear the 

Export to layer checkbox  for the colors you want to 
exclude from the recognition process. 

• The polylines resulting from vectorization will be broken at the 
crossing points with other objects. The Collect Polyline 
command is intended for correction. 
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Lesson 12: Customizing WiseImage 
Brief description: In this lesson you will learn how to customize 
WiseImage settings. 

Customizing Program Parameters 
Choose Options from the Tools menu. Go to the WiseImage tab. 

 

In this dialog you can customize the following WiseImage 
parameters: 
• Color of selected raster object, color of the program window 

background, etc. 
• Preview window style for Binarization. 
• Modifying the existing standard paper formats and adding new 

ones. 
• Defining the path to OCR template files, symbols to external 

filters folders. 
• List of operations for autocorrect. 
• Default properties for new raster images. 
• Calibration Entity properties 
For more detailed information see corresponding sections of User’s 
Guide and Help. 


